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In this Issue:
More Good Deals

Apple's Strategy for the
Future
PowerPC
Tips from Claris
The History of the
Apple II-part 7

Sign up NOW for a table at the Swap Meet!
Call our Voice Mail at 229-6952.
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Board of Directors -
Mini'app'les Members Welcome- Penn Lake Lib., 8800 Penn
Ave. S, Blmngtn - Greg Carlson,
544-8252

Apple ll/GS Main - Typeset -
Lexington Lib., University &
Lexington, St. Paul -
Tom Ostertag, 488-9979

ClarisWorks SIG -
Open discussion - Norwest
Bank, 5320 Lyndale Ave. S.,
Mpls - Denis Diekhoff, 920-2437

Macintosh Main - New products
- Mirror Technologies, 305 2nd
St. NW. New Brighton -
Mike Carlson, 377-6553

Swap Meet - call voice mail for
table requests - Apache Plaze,
3800 Silver Lake Rd. N.E. Mples
-call voice mail, 229-6952

Fourth Dimension SIG - Metro
II, 1300 Mendota Heights Rd,
Mendota Heights - Ian Abel,
920-5520

El Apple II Novice SIG - Murray Jr.
High, 2200 Buford, SL Paul -
Tom Gates, 789-1713
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Appleworks SIG - Christmas/
Holiday letters - Murray Jr. High,2200 Buford, St. Paul -
Les Anderson, 735-3953

FileMaker Pro SIG - Open
Discussion - Highland Park Lib.,
1974 Ford Pkwy., St. Paul -
Steve Wilmes, 458-1513

HyperCard SIG - Scripting Q&A- E. Lake Ub., 2727 East Lake
St., Mpls - Peter Reck, 370-0017

Macintosh Novice SIG - Open
forum- Highland Park Lib., 1974
Ford Pkwy., St. Paul -
Tom Lufkin, 698-6523

Mac Programmers SIG - Murray
Jr. High. 2200 Buford, St. Paul -
Gervaise Kimm, 379-1836

Programmer's Workshop -
THINK C Program Coding -
Brookdaie-Henn Ub., 6125
Shingle Creek Pkwy, BrooklynCtr. - Keven Kassulker,
535-2968

Macintosh DTP SIG - Call for
info - Bob Grant, 827-6294
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Past President

SIG: Macs
Membership Director

Software Director

Publications Director

S IG: App les
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New Hope. MN
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A l len Mack le r

(715)485-3585
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827-4948
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424-8889

The Minnesota Apple Computer
Users' Group, Inc.

P.O. Box 796, Hopkins, MN 55343

Adver t i se rs A NL con t r i bu te rs :
* See newletter reference section on this page
* Call Publications director listed in the board

section when reference section is Incomplete

For General informat ion:
* Call Voice Mail system - 229-6952

(Messages aren't checked daily, for
faster respondce check with NL or
meeting contacts* Read Newletter

* Attend a meeting ( please call calendar con
tacts before attending )

For detailed Meeting kiformationz
* See newletter calendar &. next mnths events
* Call contacts on NL calendar
* Changes contact NL staff

(newletter ref. section)

Bul let in Board System:
* From your computer dial 892-3317,

24 hrs-a-day to interact online.
Set your modem software to
8 data, 1 stop, 0 parity

Newletter Reference
Publication Staff:

Introduction
This is the Newsletter of Mini'app'les, the Minnesota Apple Computer Users' Group,
Inc., a Minnesota non-profit club. The whole newsletter is copy righted © by
Mini'app'les. Articles may be reproduced in other non-profit User Groups' publications
except where specifcally copyrighted by the author. (Permission to reproduce these
articles must be given by the author.) Please include the source when reprinting.

Dealers
Mini'app'les does not endorse specific dealers. The club promotes distribution of
information which may help members identify best buys and service. The club itself
does not participate in bulk purchases of media, software, hardware and publications.
Members may organize such activities on behalf of other members.

The Fine Print
The Mini'app'les Newsletter is an independent publicaiton not affiliated, sponsored,
or sanctioned by Apple Computer, Inc. or any other computer manufacturer. The
opinions, statements, positions, and views herein are those of the author(s) or editor and
are not intended to represent the opinions, statements, positions, or
views of Apple Computer Inc., or any other computer manufacturer.
Apple®, the Apple® *, Apple IIGS®, AppleTalk®, AppleWorks®,
Macintosh®, ImageWriter®, LaserWriter®, are registered trademarks
of Apple Computer, Inc. LaserShare™, Finder™, MultiFinder™ and
HyperCard™ are trademarks of Apple Computer, Inc. PostScript® is
a registered trademark of Adobe Systems, Inc. Times® and Helvetica®
are registered trademarks of LinoType Co.

Calendar Updates Erik Knopp : 636-3244
Publisher/Layout Editor

Publications Director
Hugh Johnson

Keven Kassulker
= 780-6053
i 535-2968

Mac Editor
Apple Editor

Open position
Open position

1 c a l l
! Keven

Pulletin Board Editor Open posjjion for
info

Advertisinq Director openPos-.tempKeven ;'535^29&8'"
St. Paul Area Ad Rep, j

_dt& s Metro Ad. Rep.: These positions are
i)f&NMetro-Ad.-Rep7; 0pen. For more infor-

„ E Mpls Ad Rep.!
WMpisAd.Rep i

§[eater Mn Ad. Rep. 1
Outstate / Nat. Ad. Rep. j

matton call Keven at
535-2968

Newsletter Contributions - Please send contri
butions directly to our Post Office, Box 796, Hopkins,
MN 55343 or upload them to our BBS at 892-3317.
Deadline for material for the next newsletter is the
ISth of the month. An article will be printed when space
permits and, if in the opinion of the Newsletter Editor or
Manager, it constitutes material suitable for publication.

Newsletter Credits:
AppleLink Liaison
Graphics Contributer
Story Contributer
Story Contributer
Story Contributor
Story Contributor
Story Contributor
Story Contributor

Tom Mehle
Roy Sorenson
Ken Slingsby
Peter Fleck
Tom Ostertag
Tom Gates
Steve George
Greg Carlson

536-3972
870-7366

(507)263-3715
370-0017
488-9979
789-1713
935-5775
544-8252



N e X t M o n t h ' s E v e n t S D e c e m b e r, 1 9 9 3- v.v.-.v. ■>.•- '>*-y.- y.<'y.vf$$w6ffi
Board of Directors 7:00 Thr, Dec. 2 -location pending- Greg Carlson, 544-8252

I Macintosh Main 7:00 Thr, Dec. 9 -location pending- Mike Carlson, 377-6553

Programmer's Workshop 1:00 Sat, Dec. 11 Brookdale-Henn Lib., Brkln Ctr Keven Kassulker, 535-2968

Apple ll/GS Main 7:00 Mon, Dec. 13 Lexington Lib., St. Paul Tom Ostertag, 488-9979

Apple II Novice SIG 7:00 Tue, Dec. 14 Murray Jr. High, StPaul TomGates, 789-1713
ClarisWorks SIG 6:30 Tue, Dec. 14 Norwest Bank Lyndale S., Mpls Denis Diekhoff , 920-2437

! AppleWorks SIG 7:00 Thr, Dec. 16 Murray Jr. High, St. Paul Les Anderson, 735-3953
FileMaker Pro SIG 7:00 Thr, Dec. 16 Highland Park Lib., St. Paul Steve Wilmes, 458-1513
Fourth Dimension SIG 7:00 Mon, Dec. 20 Metro II, Mendota Hts Ian Abel, 920-5520
Macintosh Novice SIG 7:00 Mon, Dec. 27 Highland Park Lib., St. Paul Tom Lufkin, 698-6523

HyperCard SIG -Suspended- -Resumes in January- Peter Fleck, 370-0017
Mac Programmers' SIG -date pending- -location pending- Gervaise Kimm, 379-1836
Mac DTP SIG -date pending- -location pending- Bob Grant, 827-6294

| Coordinators - Please contact Erik Knopp (on our BBS or at 636-3244) by the 1st of the month to have your meeting listed correctly.

Need Help? Have a question
the manual doesn't answer?
Members Helping Members
is a group of volunteers who
have generously agreed to
help. They are just a phone
call away. Please call only
during appropriate times, if
you are a Member, and own
the software in question.

ROY SORENSON

Macintosh Key
Adobe Illustrator 21
Beginners 13,14,18,24
Canvas 5
FileMaker II, Pro 1,17
Freehand 22
General 14,17,18,24
Helix 16
HyperCard 6,9
MacDraft 5
MacDraw 5
MacPaint 5
Mac OS 4,18,24
Microsoft Excel 5 ,6 ,17
Microsoft Word 4,5,6,14,17
Microsoft Works 11,17
Networking 5,6,13
PageMaker 4,6,17
PostScript 8
PowerPoint 5
QuickBasic 5,6
XPress 21

SteveWilmes
Tom Ostertag
Tom Gates
Tom Edwards
Earl Benser
Dan Buchler
Ann Bell
Fritz Lott

458-1513
488-9979
789-1713
927-6790
884-2148
435-3075
422-1115
377-3032

E
E
EW
E
EW
E
E
E

9.
10.
11.
12.

13.
14.
15.

Peter Fleck
Randy Dop
Ed Spitler
Bob Rosenberg

John Hackbarth
Jim Horswill
Tom Michals

A p p l e I I K e v
A p p l e W r i t e r 2
A p p l e W o r k s 2 , 2 3
A s c i i E x p r e s s 3
B A S I C 5
D a z z l e D r a w 2 3
D B M a s t e r 7
Educational Software 23
General Information 23
H o m e A c c ' n ' t 2 0
P u b l i s h l t ! 2 3
P r o T E R M 2 3
Q u i c k e n 2 3
Ta l k I s C h e a p 3
T i m e O u t 2
T O G r a p h 2

A p p l e / / / K e y
G e n e r a l 1 2

A p p l e H G S K e y
A p p l e W o r k s G S 1 5
A P W 2 0 , 2 3
Complete Pascal 10
D e l u x P a i n t I I 2 3
General Information 3,10
Graphic Writer ll/lll 15
G S / O S 3 , 1 0

HyperS tud io GS 3
M e r l i n 1 6 + 1 5
M o u s e t a l k 1 5
PaintWorks Plus/Gold 15,23
P r o s e l 2
T M L B a s i c 3 , 1 0
T M L P a s c a l 3 , 1 0
Wr i t e r ' s C h o i c e 1 5

If you would like to be a
"Members Helping Members"
volunteer, please leave your

name & phone number on our
BBS or leave a voice-mail

message at 229-6952.

370-0017
452-0425
432-0103
377-4300
340-0234

715-245-6561
379-7624
452-5667

DEW
EW
D
EW
D
D
DEW
DEW

16.
17.
18.
20.
21.
22.
23.
24.

Amie Kroll
Michael Foote
Richard Becker
Steve Peterson
JodiRoste
Nancy McClure
Rand Sibet
Hugh Johnson

433-3517
507-645-6710

870-0659
922-9219
933-1698
227-9348
566-8571
780-6053

E
DEW
EW
EW
EW
DEW
EW
DEW

D-days (generally 9 a.m. to 5 p.m.), E-evenings (generally 5 p.m. to 9 p.m.), W-weekends (generally I pm. to 9 p.m.).
In any case, call at reasonable hours and ask if this is a convenient time for them. We appreciate your cooperation.
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MeetingNews
Apple II Main
Meeting
by Tom Ostertag

The October meeting was at the Lexington
Branch Library in St. Paul. Most people had
gathered by 6:45 an stood in the lobby
blocking rraffic waiting for another group ro
leave. Erik had the computer and rhc accessory
equipment and Owen Aaiand had the
software... so wc were in business.

Announcements were made for the Swap
Meet in November and the Hamfcst Swap
meet the end of October. The AppleWorks
meeting will include demonstrations of your
favorite AppleWorks Templates.

Randy Peterson had a number of questions
about hard drive interface cards and there were
a couple of questions about Apple News.

Erik did an ad hoc presentation of Typeset
and passed out literature and order informa
tion. Then yours truly did a demonstration/
discussion of Publish Id and desktop publish
ing. This generated a lively discussion of what
other ways there were on an Apple //c to
generate this type of output.

Unfortunately, the discussion was inter
rupted by the Librarian kicking us out.

Pic SIG was at the Perkins in Midway
Center where there was a lively discussion of
computer history, Newtons, Apple Manage
ment (or lack thereof...) and the local
downloads available.

November's meeting is also at the Lexing
ton Library and hopefully will be on games (If
I can find someone to do a game demo...) See
you there.

A l l f o r n o w . . . T o m 6

Mac HyperCard SIG
Report
by Peter Fleck

Attendance was up at the September SIG
meeting— 15 HyperTalkcrs present. We
talked about basic scripting and a bir about
using QuickTime in stacks.

Beginning in November, I will try to
provide some shareware stacks at each
meeting. Instead of copy ing your own, please
bring an unformatted (meaning new) l.4mb
(high density) floppy and you can trade it in
for a disk of stacks. The stacks will be stuffed
so you need to have some sort of unstuffing
tool to get at them. Stufflt Expander is one of
the best and I'll have that on the first disk
distributed. It is a free program.

That's all for this month... Pete
Next Meeting: Monday, November 22 at

the East Lake Library in Minneapolis, 2727
E. Lake Street, near Minnehaha Mall, Target,
Rainbow, and Podany's.

Times: 7:00 - 8:45
Directions: From 1-94, take rhe 25th Ave/

Riverside exit and go sourh on 25th (becomes
26th) to I-ake Street, then left 1 block. There
is a parking lot behind the library, on-strect
parking (you don't have to plug the meters
after 6 p.m.), and a church lor just east (don't
use the church lot if it looks like something is
going on at the church, please).

Topic: General discussion of scripting.
Maybe a quick look at an AppleScript if I
have time to prepare.

Upcoming Meetings: No Meeting in
December! Watch the December newsletter
for the January meeting date. 4

Fall Swap Meet
Saturday, November 13, 10 am-2 pm
Apache Plaza Shopping Center,
3800 Silver Lake Road, N.E. Mpls
Table info:
Members: 1/2 Table: Free
Whole Table: $10.00
Vendors/Non-Members:
1/2 Table: $15.00
Whole Table: $25.00
Leave message at: 229-6952
(Mini'apples Information line), with
Name, Phone #, Table Requirements and
Membership # (if applicable).

Attention Apple II Owners!
New at the November 13th Swap Meet:
The Apple II Test Bench Area
Questions on Software? - We'll have a //e, /
/c and GS available to look at your
questions.
Possible Hardware Problems? - Also
available will be an assortment of diagnos
tic software to check your equipment if
you'd like to bring it in.
To get more information, call the
Mini'apples Information line, (612) 229-
6952, a 24-hour service, and leave a
message - we'll contact you and answer
any questions.

Attention all Members:
If you do not wish to have your name,
ZIP, and phone number to be listed in
the soon-to-be-released membership
roster eDOM, please send a note to
the Membership Director at PO Box
796, Hopkins, MN 55343

RE: the new ClarisWorks SIG
Remember to enter the bank by the
rear entrance. Do not
park in the liquor-
store parking lot
For further
details, call
Denis Diekhoff,
920-2437.



Mini'apples Board of Directors
Meeting Minutes
September 2,1993

Norwest Bank, Minneapolis
Presiding Officer Greg Carlson, President

PreliminaryAttendance
Members: Greg Carlson, Jacque Gay,

David Laden, Erik L. Knopp, Al Mackler,
Sam Goshorn, Roy Sorenson, Bob Demeules,
Keven Kassulker.

Absent: Tom Gates, Wade Brezina
Guests: Lance Weber, Sue Goshorn, Hugh

Johnson.
Meeting called to order by President Greg

Carlson at 7:12.
Adoption of Agenda: with addition of trial

eDOMs, agenda passed.
Aug. 5 meeting minutes approved with

minor corrections.
Treasurer's Report—Jacque Gay

see Treasurer's Report.
President's Report—Greg Carlson

Mail box: Rand Sibet has resigned mail
pickup duties. Wayne Couillard has agreed to
take on mail pick up and distribution, as he
lives within blocks of the Hopkins P.O. box.
David explained the club's address relates to
its origin in Hopkins.

Exchange Newsletters: Greg distributed
exchange newsletters we get from other user
groups. Discussion of how they should be
routed, and how many we are sending out in
exchange—see new business section for
further discussion.

Hamfest will be Oct. 30, and Greg asked
that a notice appear in newsletter.
Membership Director's Report—BobDemeules

see Membership Report. Discussion on
why we don't have more renewals: someone
suggested it was "sticker shock" of members
at the $25 rate. Keven also reported contin
ued problems (and frustration) with meetings
not being held where and when expected.
Software Director's Report—Sam
Goshorn

3 new eDOM disks are coming. Also
announced that 3 Mac eDOMs, (#859,861,
and 862) have been discovered to have the
WDEF virus (which does not affect System 7
desktops). Sam will put notices on the BBS
and to the newsletter, and offer exchange for
dean disks. Sales $19 mail order, $10 Mac
eDOMs for $29 total eDOM income.
Apple II SIG Director's Report—Erik
Knopp

Sires and dates are scheduled through
December for the main Apple II meeting and

possibly for the other Apple SIGs.
Publication Director—Keven
Kassulker

Keven is working with others on a flyer for
ad sizes and rates. There was discussion on
what our current ad rates are: David gave
some reasons and history for the ad rates.
Keven and Hugh will review and clarify them
and report back to board. Lance announced
that he will be unable to be ad coordinator.
This is a very important position for the club,
and members who can help should call
Keven.
Operations and Resource Director—
Al Mackler

No report.

Old Business
Membership List:

The notice has appeared once in the
newsletter. It was suggested the next notice
mention the list would appear on eDOM.
Fall Swap Meek

Set for Saturday, Nov. 13 from 10 — 2 pm
at Apache Plaza. Greg will ask Tom to
contact TC/PC if they would like to attend,
and to prepare ad copy for the newsletter.

Anoka Apple Club was not meeting over
the summer, so coordination discussion was
deferred.
Newsletter Donation:

Greg will arrange for Sue to get a selection
of newsletters to submit to the State
Historical Society.
Grants:

Sue gave a long report on the grant
proposal process. Discussion: we have
resources to draw on, including our mission
statement, the bylaws, the survey results, and
the results of the general business meeting
brainstorm sessions. Consensus was that
preparing a grant proposal would be a major
undertaking, and we lack a clear vision of the
process. Sue was asked to distill the process,
and include a decision time line to help us see
the whole system.
Name Change:

Discussion followed a recommendation
from the executive committee that the
proposal for a change of name for the user
group be dropped, in view of more pressing
concerns and a lack of unanimity for an
alternative name. Morion to drop the name
change from active consideration was made
and seconded: Keven voted no, the rest of the
board present voted yes, passing the morion.

New Business
Discussion on the number of complemen

tary and exchange newsletters, the routing of
them within the group, and if the benefit
outweighs the cost. We pay to send out over
70 such newsletters each month. Are any of
them superfluous? Many members were
surprised to see the number of exchange
newsletters, which haven't been widely
distributed or routed. Dave pointed out that
some "complementary" newsletters are to
members or advertisers. The economics of
printing extra newsletters has changed with
recent changes in production that were a
response to decreased membership (the per-
issue cost has increased). Decision: Greg will
tell the mail pickup person to keep track of
the newsletters we get over the next 2
months, so the board can evaluate the
exchanges. Routing of exchange newsletters
will be changed to first Bob (Memberships,
keeper of the mailing list) and Keven
(Publications), then the board and out to
SIGs.
Audit of Books:

Jacque reported she delegated the task of
leading an audit committee to Dick Peterson.
Trial EDOMs:

Discussion of trial proposal to issue 100
free eDOMs as club promotion, targeted for
(dealers to give to) computer buyers and for
people taking computer classes. Each disk
might include the club eDOM catalog, a
membership form, and Disinfectant. Jacque
said the file size and speed variables would
prohibit including the club promotional stack
she wrote. Club cost would be 100 (800 k)
disks for about $65 (plus minimal cost of
printing disk labels). How many member
ships would we get from 100 disks? How
many would we need to recoup promotional
costs and member benefits? Morion for the
executive committee to report a specific
recommendation on this matter for board
consideration seconded and passed.

Adjournment moved, seconded and
approved.

Next board meeting:
Thursday, October 7 at Washburn

Library, Mpls.
Next Executive Committee meeting Sept.

I6atjacque's

prepared and submitted
by Roy Sorenson, Secretary 4



GOOD DEALS
by Ken Slingsby
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This is part of the scries of articles which
list good deals and press releases that have
been brought to our attention via a news
source established by Apple Computer Co,
AppleUnk. Due to the constraints of space in
our newsletter and time available, the articles
have been greatly condensed. All were posted
in their entirety on the Club's BBS. To read
the full articles, plead or beg a friend who has
access to the BBS to copy it for you.

As an aid in your review of the articles, I
have divided them somewhat arbitrarily into
DEALS and Press Releases. The DEALS
include price, dates available, and the address
of the publisher or author. Most of the
DEALS are special limited time offers of a
significant price reduction. They are
presented here as a service of Mini'app'les.
The PRESS RELEASES are to make you
aware of the new products. You may have to
hunt to find a dealer to find the product.

Mini'app'les makes no claim as to the
usefulness or quality of the products offered
herein. The User Group does not endorse the
products and is not supporting the products.
The following is not paid advertisement.
There may be other products mentioned on
AppleLink nor appearing here. If so, that is
an omission, not a refusal of the product. As
in all purchases, buyer beware!

In order to qualify for some of die items
presented here, you MUST be a member of
an Apple User Group. Be prepared to give
your member number, and tell them that
Mini'app'les sent you!

DEALS
3-D Tutor

We are shipping a new product which
might be of interest to you and your group.
3-D Tutor, is a visually exciting CD-ROM
that supplies the tools, techniques and
technology to allow users to become 3-
dimensionally literate. The first multimedia
resource of its kind, 3-D Tutor is for anyone
interested in learning the basics of 3-D
modeling and animation.

3-D Tutor requires a Macintosh with an
available 5mb of RAM to run the products,
8mb of RAM to run the test drive module,
System 7.0 or greater and a CD-ROM drive.

The Suggested Retail Price of 3-D Tutor is
$119.95, but we are offering it to user group
members for $60 through December 25,

1993. Members just need to ask for the user
group discount and name their user group
when ordering. - Scott Mize

Zelos!
110PacificAvcnue,#219
San Francisco, CA 94111
415-788-0566 (voice)
415-788-0562 (fax)

2WAY TALKER
The full-duplex, real-time voice communi

cation software for Macintosh computers. 2
Way Computing, Inc has a new program for
Macintosh users that enables two-way voice
communication over a network such as
Ethertalk or Localtalk. 2Way Talker 2.0.1 is a
program that allows two users to talk to each
other using the built-in microphone and
speakers of Macintosh computers.

Introductory price is $49.95 per copy.
Bulk pricing and educational discount are
available. Upgrades from previous versions
are free.

2 Way Computing, Inc
4370 La Jolla Village Drive, Suite 400
San Diego, Calif. 92122.
Voice (619) 452-3888
Fax (619) 452-3077

ReadySetGrow!
Carries parents from pre-conception to

Kindergarten and is very fun and easy to use.
Click on different objects in the Nursery
scene to access all eight parts of the program.
Some of the features include
• The pregnancy section illustrates what

your baby looks like throughout your
pregnancy, and fully details a multitude of
mother's and father's concerns.

• The "Biological Clock" gives you a
running countdown til your due datc.to
the minute, just for fun!

• Calendar program will not only help you
schedule your busy day, it will allow you
to record your children's precious
milestones, journal the events... in a diary
section.

• Address book section stores and maintains
vital information on all the important
people in you kid's life.• The Childhood section is extensive, giving
information on health care provider visits,
and various topics like feeding, burping,
how to handle whining, thumb-sucking,

you name it!* The Medical Records section allows you
to store, maintain and print medical files
on all family members. In short, there is
no other software that does so much for so
litde that you can enjoy for many years.
BUY READYSETGROW! BEFORE 12/

31/93 AND YOU GET IT FOR LESS
THAN HALF PRICE SUGGESTED
RETAIL PRICE IS $69.95, BUT THIS
OFFER LETS YOU BUY IT FOR $29.95!

Fax your order to 713-973-2440, or call
800-777-BABY. - (Elisa Medhus, M.D..
Atlantis Software Link ASQ

Prolog
Celebrating the 7th anniversary of the

introduction of AAIS Prolog on the Macin
tosh, Advanced A. I. Systems, Inc. is proud to
announce that from September 1, 1993 to
December 31, 1993, we are offering our latest
complete object-oriented version of our
popular AAIS Full Control Prolog for the
Macintosh at an amazing low price. Thus
creating a special opportunity for anyone to
now afford joining the thousands of users of
our professional Prolog. AAIS Full Control
Prolog is an object-oriented Macintosh
development system of the popular Prolog
programming language. Prolog is a symbolic,
rule language.

The product includes approx. 680 pages of
documentation, and almost 15,000 lines of
Prolog code.

Suggested Retail Price US$495
Special Discount Price US$199

Advanced A. I. Systems, Inc.
P.O. Box 39-0360
Mountain View, CA 94039-0360
Voice (4l5)-948-8658
Fax: (4l5)-948-2486

Defying Gravity
"Defying Gravity: The Making of

Newton" (Beyond Words Publishing,
Portland) is off the press and available to Mac
and Newton User Group members You pay
only $19.95 to receive this unprecedented,
inside look at Apple Computer during the
development of Newton, with over 130
black-and-white documentary photos, 30,000
words of text by Newsweek correspondent
Markos Kounalakis, and an introduction by
industry analyst Paul Saffo. This first-edition,
jacketed collector s item is bound in a 192

/^ |v



page hard-cover volume.
For a limited time, order direct from the

publisher via AppleLink at
jp^ BEYONDWORDS and the publisher willC also pay the postage and handling, an

additional savings of $5.95 (in the US and
Canada).

PRESS RELEASES
BITJUGGLERS SHIPS
UNDERWARE®

The fun of a screen saver while you work.
Mountain View, California, September 17,
1993-Bit Jugglers, Inc today announced the
first shipments of Under Ware, a new
Macintosh software product that combines
traditional screen-saving capabilities with
desktop animation and desktop pattern
customization.

UnderWare provides three modes:
1) Dynamic Desktop. This mode runs

UnderWare's animated modules and After
Dark modules on the Macintosh desktop.
The difference between UnderWare's
Dynamic Desktop and traditional screen
savers is that UnderWare runs while the
computer is being used-under your
windows and icons-while products like
After Dark only run when a computer is

asleep.
2) Screen Saver. This mode runs UnderWare

and After Dark modules as conventional
screen savers. Screen saver modules run on
top of the screen, blanking out layers
underneath and preventing screen burn
in. UnderWare adds more to the
conventional screen saver animation that
interacts with your Macintosh environ
ment.

3) Desktop Partem. Marble, oak paneling,
water drops and barn siding are just a few
of the custom desktop patterns users can
choose from with UnderWare.

The suggested retail price of UnderWare is
$59.95.

Bit Jugglers, Inc
785 Castro Street, Suite C
Mountain View, CA 94041.
The phone 415-968-3908 (voice)
fax 415-968-5358.

CONNECTDC SHIPS ON THE
ROAD FOR POWERBOOKS

Printing, faxing and network connections
simplified for PowerBook travelers "On The
Road enables traveling PowerBook users to
prepare documents and faxes just like they do
at the office. When they arrive at any familiar
facility, On The Road recognizes the

location, automatically prints and faxes, and
instantly configures all network services
according to the set-up used on their last
visit. It's the complete solution for anyone
who takes their PowerBook on the road. We
are very pleased to add this to our growing
line of portable computing products,"
explained Roy McDonald, President and
CEO of Connectix. On The Road is available
now worldwide through retail oudets, mail
order firms and distributors. Registered users
of Connectix PowerBook Utilities and other
Connectix products can purchase the product
for $29.95 by contacting Connectix at (800)
950-5880.

Fantastic prices on refurbished
equipment

From time to time, the Apple User Group
Connection offers refurbished equipment for
sale at usually 50-60% of new price. For
instance, the October offering included a
Performa 200 and a StyleWriter I printer,
each at the reduced price. Complete details
are not induded here as the offer is made and
expires in October. If this continues, the only
alternative I can see is for each of us to
purchase a modem and call the Mini'app'les
BBS for the latest details.

News from the Software Director
Mini'app'les is now authorized to distribute
several new software packages from Apple:

Apple II System 4.0.2
Apple IIGS System 6.0.1
Extensions Manager 2.0.1
Hardware Update 2.0
LaserWriter 8.0
QuickTime Extension 1.6.1
System Enabler Collection 1.0
Threads Manager 1.2

Extensions Manager 2.1 allows you turn
"off* or "on" the code that executes at startup
in certain "extension documents" such as
Control Panels, Chooser devices and INITs
(known before as startup documents). It also
allows you to choose which ft files should be
opened under System 7.1.

Hardware System Update 2.0 offers
additional software improvements to meet the
ongoing needs of Macintosh users. It also
contains software enhancements to address
specific problems encountered by some
Macintosh computer users. This update

requires Macintosh System Software version
7.1 and is not intended for Macintosh
Performa users.

QuickTime 1.6.1 software consists of the
QuickTime system software extension, a new
version of the Macintosh Scrapbook and a
Scrapbook file with a sample movie. The
QuickTime system software extension adds
capabilities that let your application programs
integrate graphics, sound, video, and
animation into documents. B providing a
standard way for all Macintosh programs to
control these multimedia elements,
QuickTime makes them easier to use. In the
new Scrapbook, you can cut, copy, paste, and
play QuickTime movies. Larger images will
also shrink to fit so mat you can see the entire
image in the Scrapbook window. This
Scrapbook is otherwise identical to the
standard Macintosh Scrapbook.

System Enabler Collection 1.0 is a single
floppy disk that contains all of the system
enabler files Apple has released since October
1992. This software requires Macintosh

System Software 7.1, and when installed,
resides in the computer's stem folder. System
enablers are system files that allow System 7.1
to operate on Macintosh computers released
since October 1992, including the
PowerBook Duo 210 and 230, the
PowerBook 160,180,165C, the Macintosh
IIvx, Ilvi, the Color Classic, the Macintosh
LC III, Quadra 800, and Centris 610 and
650 Macintosh computers introduced before
October 1992 do not need a system enabler
to operate with System 7.1.

Threads Manager 13. is a System 7
extension which allows applications to make
use f both cooperative and preemptive
multithreading within an application context
o all Macintosh platforms. This release
contains Thread Manager 1J2, new header
files, and an updated source level debugger
along with an updated utilities library.

prepared and submitted by Sam Goshorn,
Software Director #



Apple's Strategic Directions
This article consists of terse notes, written by an
anonymous attendee at a semi-confidential
corporate briefing. The information is here
presented with very litde editing or "prettying-up ".
Please feel free to read between the lines and make
as much sense of it as you tike.

Apple's Strategic Directionsas of 10/13/93
"The Future Isn't What It Used To Be*
Current technology focus is on computation
(database, word processor, spreadsheet)
Reshaping this focus by incorporating:• Human Communications - speech, video.
• Anytime, Anywhere - mobility, moving off

the desktop, putting the "personal" back in.
• Changes in functionality, form factor, user

interface.
Making Complexity Simple-
Human Interface Leadership.
• Speech, handwriting recognition, Intelligent

Assistance, Advanced Help, Natural
Language.
The GUI is not the ultimate answer; there
are better metaphors! Advances in compute
power make new interfaces possible

• Expect to see Speech Interface on a variety of
platforms via the portable software
architecture Apple has implemented.

• Handwriting recognition to spread on
mobile devices.

• Current GUI is the "manual transmission'' -
you have to stir the gears, show the
computer what you want to do. Intelligent
Assistance will supply the "automatic
transmission" — to be seen on Newton and
Macintosh.

• Advanced help - systems that answer "How
do I...?" questions rather than "What Is
This?" questions (balloon help).

• New help system to be out in about 6
months, incorporating sound, video - will
have hooks for custom development;

• Natural language - still short on horsepower
- time frame is about 2000.
It is just becoming possible/feasible to release
this kind of technological advance in the sub
$5000 price range. Expect New OS release
in March 1994; enhancements to the current
GUI. The next 18 months promise to move
us beyond the GUI. Apple is moving
towards software — "hardware is a
commodity...and the OS may be also" -
added-value services and functionality are
the focus.

Themes in Human Communication
(more than WP/SS/DB).
• Messaging - PowerTalk/AOCE; integrated

at the OS levd.
• Telephony - fax, answering machine, PBX

interface, voiccmail.
* Video Conferencing - point-to-point video

over LANs.
* Speech - input and output.
* MultiMcdia - digital video, stereo sound.

The AV machines are not multimedia PCs -
they arc an implementation of the above
technologies as mainstream technologies.
These technologies to be available "across the
board" over the next 18 months.

Redefining Price / Performance* PowerPC - workstation performance at

personal computer prices.
* 4 to 16 times the performance of a Quadra

800 at the $2000 price point.
Cross Platform Compatibility

Setting and supporting industry standards.
Database access (currendy DAL for DB2
access). Macintosh as the "Universal Client"
- run Any Windows or Mac application.
Run Windows apps at 486 performance
levels on the low-end PowerPC.
As PowerPC evolves, believe it will run
Windows faster than native Intel.
Newton - designed to work cross-platform -
this is not a Mac peripheral - there will be
strong emphasis on Windows connectivity in
the near future.
Cross Platform "services" Toolboxes for
Unix, Open Systems, Windows.
QuickTime, PowerTalk, Macintosh Services
for Open Systems, AppleSearch, OpenDoc
document architecture (available next year
for Mac, Unix, Windows).
Taligent-1995/96.
Imaging and Peripherals - spring 1994 -
image capture devices, printers, monitors
targeted directly at the Intel market.

Axiytime/Anywhere
Aiming to "totally dominate" the mobile
computing arena.
Mobile Desktop - PowerBooks.
Mobile Information Services—Apple
OnLine Services, Newton GlobalMail -
November announcements.
Personal Electronics - Newton and more -
optimize the solution to die problem.
Wireless communications.

Apple Product Framework
The goal is to become "hardware and
software agnostic" - The value added is in
the service.

• Server Services - moving to open, scalable
server architecture based on Unix.
PowerOpen - IBM's A/DC kernel standard -
licensable by others. Apple will not "roll
their own" UNIX in the future. Based on
PowerPC, consistent and scalable with IBM
RS/6000 (Apple on the low-end, IBM on
the high-end, sharing a single architecture).

• Advanced Server Services - cross-platform
implementations
PowerShare collaboration services. Advanced
Retrieval and Information filtering
(AppleSearch). AppleTalk Remote Access.
Targeting Novell environment (NLMs). No
reservations about porting to NT if it proves
financially feasible

• Desktop Services - "Middleware" -
differentiation via Apple Services.
AppleScript, WorldScript, QuickTime,
OpenDoc QuickDraw GG PowerTalk,
Color Imaging. Move from application-
centric focus to document focus with "parts
editors" - composite document architecture
with focused "objects".

• Macintosh Hardware — "Computation plus
Communication".
68030->68040->68040+DSP->PowerPC
Pursuing license of Macintosh on PowerPC
— Macs from other vendors!

• PowerPC - single chip RS/6000.
$1 billion invested to this point. Simulta
neously developing 4 chips; all to be released
over next 15 months

• Hardware Reference Platform - IBM &
Apple.
Define minimum core set of functionality
common to all machines from either
company—standard to be agreed on this
year (the first round of PowerPC machines
might NOT be compliant). Each company
will then be free to enhance or add on to the
base. IBM project "SandalFoot" is creating
board-level OEM products based on
PowerPC - puts IBM back in control of its
hardware platform. "PowerPC will become
the dominant RISC architecture in it's first
year of release."

PowerPC Transition.
• App compatibility - expect 95% of today's

apps will run. Hardware upgrades - logic
board swap or PDS card add-in for Q800,
610,650, Mac IIvx.
Announcement to be made in November 93
- 3rd parties to provide 68030-platform
upgrade path. Ongoing 680x0 operating
system support, hardware to be shipping for
many years to come (5 year future). Project 1
million PowerPC units sold in 1994 (only
23% of current volume).
No PowerBook upgrades for current models
- there will be future PowerBooks (March
1994) which are 68040 based that can(?) be
upgraded to PowerPC 603 chip. Announce
ments in March 1994 with a high level of
availability (machines and upgrades).

"The Past Is Not a Predictor of the Future* #
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Apples PowerPC Announced
excerpts from a press release

CUPERTINO, California- October 19,
1993 - In a series of announcements at major
industry events this week, Apple Computer, Inc
is demonstrating growing momentum behind
and support for the next generation PC
platform: Macintosh with PowerPC...

In summary, Apple announced the following:
• Seven additional software developers have

announced plans to develop new "native"
versions of applications for the PowerPC
(there arc 18 total now).

• Plans to deliver higher dock speeds for
RISC-based Macintosh systems.

• Additional details on its PowerPC upgrade
program for current customers.

• Delivery of firsr silicon of the PowerPC 603.
This week's progress update coincides with

three major conferences where PowerPC will be
discussed:
• The Microprocessor Forum in Burlingame,

CA
• The Scybold Publishing Conference in San

Francisco
• The EDUCOM education conference in

Cincinnati.
Re-affirming that Apple is on schedule for its

planned introduction of systems based on new
RISC technology during the first six months of
1994, Apple plans to exhibit Macintosh with
PowerPC prototype systems and demonstrate a
selection of applications that are under
development at both Scybold and EDUCOM.
Major Developers Committed to
PowerPC

The 7 new developers announcing native
applications support for PPC arc Artwork
Systems, N.V., Canto Software, Inc, Fractal
Design Corporation, Graphisoft, Great Plains
Software, ITEDO Software GmbH., and
Wolfram Research, Inc

Developers previously committed to
developing native applications include: Adobe
Systems Inc, ACIUS Inc, Aldus Corporation,
Claris Corporation, Deneba Software, Frame
Technology, Insignia Solutions, Microsoft
Corp., Quark, Inc, Specular International, and
WordPerfect Corporation.

At both the Scybold and the EDUCOM
conferences, Apple plans to publicly demon

strate for the first time a selection of native
applications: Aldus FreeHand, Insignia SoftPC
Adobe Photoshop, Fractal Design Painter,
Specular Infini-D, Wolfram Mathematica.
Affordable Upgrade Paths

Today, Apple also announced plans to ship
upgrade products simultaneous with the initial
introduction of Macintosh with PowerPC
systems, and added an upgrade path for Apple
Workgroup Servers
Increased Microprocessor Performance

In co-operation with IBM and Motorola,
Apple announced that the performance of the
PowerPC 601 chip has exceeded original goals
and plans to ship at higher frequencies (speeds)
than earlier announced. The minimum speed of
RISC-based Macintosh systems has been
increased from 50MHz ro 60MHz. Addition
ally, Apple announced that it also plans to ship
80M Hz systems during 1994.

Also this week, Apple with IBM and
Motorola announced that the second PowerPC
chip, the 603, has reached first silicon.

submitted by Arnold Ziffle 4

Apple Unveils MacintoshTV
abridged from a press release

CUPERTINO, California - Oct. 25, 1993 -
Apple Computer Inc announced today
Macintosh TV, a new product that combines an
Apple Macintosh personal computer, television
and CD-ROM stereo system into one compact,
low-priced unit. Designed for users at home and
in higher education institutions, the $2,079
system gready reduces the cost and space
requirements currently required to obtain these
electronic components separately. This product
underscores Apple's business strategy to reach
new users in the home and education markets.

Macintosh TV provides the integrated
functionality of a powerful personal computer
with a cable-ready 14-inch color TV, and
double- speed audio CD player for high-quality
stereo sound. The system can also be easily
connected with a VCR, camcorder, laserdisc
player or video game player. In addition, it
comes with a sleek infrared remote that controls
both television and CD player functions.

The computer industry and the consumer
electronics market are converging, and Apple is
at the forefront of this transition," said Brodie
Keast, Director of Product Marketing for the
Apple Personal Computer Division. "With
Macintosh TV, Apple extends its popular all- in-
one computer design with new media capabili
ties that create a whole new category of
computing and entertainment devices."

"With this special edition of the Madntosh,
Apple hopes to learn more about the needs of
this market and to apply that knowledge to
future product devdopment," Keast added.
Bundled Software Included

Macintosh TV comes bundled with several
popular software programs pre-loaded, induding
ClarisWorks 2.0 (an integrated program
combining a word processor, spreadsheet and
database),

American Heritage Dictionary, Mavis Beacon
Teaches Typing, HomeWork Templates, and
The Performa Click An Collection. It also
indudes CD-ROM tides such as Groiler's
Multimedia Encydopedia, World Atlas, Space
Shutde, Wonders of the World (Volume I),
Time Almanac 1993, and the Kodak Photo CD
Sampler.
Product Details

Madntosh TV combines plug-and-play
simplidty with the power of a 32 MHz 68030
microprocessor. It comes standard with 5MB of
RAM expandable to 8MB. It has a 160MB hard
disk drive and a 1.4MB Apple SuperDrive
floppy disk drive and reads MS-DOS disks with
Madntosh PC Exchange software

The television capabilities indude a 14-inch
Color IV with a cable- ready tuner, a coaxial
port to connect an antenna or cable service and a
RCA port to connect a VCR, camcorder,
laserdisc player, or video game player. The

software support for tdevision features indudes
frame grabbing, dosed captions, channd
scanning, and password protection of TV mode

The AppleCD 300i double-speed CD-ROM
drive adds more flexibility to Madntosh TV and
provides a richer more exdting computing
environment. This built-in CD-ROM plays
standard audio CDs, reads data on CD-ROMs
and views images on Kodak Photo CDs. The
system integrates a high-quality 14* Trinitron
color display which provides 640 by 480 pixds,
.26mm dot pitch and 8-bit color, displaying 256
colors.

The SCSI port will support up to six SCSI
devices, such as hard disks and scanners. There
are two serial ports for printers, modems, and
AppleTalk networks. There are also two Apple
Desktop Bus (ADB) potts for keyboard, mouse,
and other input devices. Madntosh TV also has
built-in AppleTalk networking and file sharing
without a dedicated server.
Pricing and Availability

Madntosh TV is a U.S. only, spedal edition
product and will be available immediately upon
introduction at sdected consumer retail scores
and higher education campuses, and through
the Apple Catalog. The consumer stores indude
Besr Buy, Sdect Video Concepts, Silo YES, and
TOPS. The ApplePrice is $2,079.

submitted by Speedy Gonzalez #



Tips fromtheClarisFaxAnswerline
Claris has a fax amwerline for commonly

asked questions and "workarounds" for thdr
programs. The fax answcrlinc is available to
anyone with a fax machine, and can assist with
various problems that can occur with your Claris
programs. Programs induded are AppleWorks,
AppleWorks GS, ClarisWorks, ClarisCad,
FileMaker series, HyperCard and other Claris
programs. You can call the Answerlinc by
dialing 800-800-8954 and follow the infrac
tions to get "catalogs" of the documents
available.

In the interest of those that do not have the
benefit of a fax machine, some of the rips will be
presented here:

AppleWorks:Unable to Insert or Add Records to the
Data Base

If any of the following symptoms occur:
1. Cannot insert or add any new records to

the Data Base in AppleWorks I .x - 2.0;
2. An existing record is always displayed after

pressing Open Applc-I ro insert a new
record;

3. The computer freezes when Open Apple-I
or Open Applc-Z is entered; try printing
the Data Base information to a new ASCII
or DIF file. Then, create a NEW Data Base
from that ASCII or DIF file

"Cannot Write to Disk" Message
Problem: Unable to save or print a file to disk

on drive X, even through there is plenty of room
on the disk.

Explanation and Solution: The problem is
more likdy to occur when using 3.5-inch disks
or hard drives. ProDOS dlows only 51 files/
directories in the Root directory, no matter how
much extra room is available on disk. The
solution is to remove some files or subdirectories
from the root directory (Put these files in other
subdirectories or on separate disks.)

Note: Since AppleWorks always creates a
temporary file on disk when saving, the
maximum limit of files/directories in the Root
directory when using AppleWorks is 50.
Unable to Access Internal Drive of a Ik
Plus with AppleWorks 2.0

When using AppleWorks 2.0 and an Apple
He Plus computer, if the message, "Getting
errors trying to read directory at Built-in disk"
appears on the screen when trying to retrieve or
save files to the built-in 3.5-inch disk drive, try
the following:

Sec the current disk drive to Disk 3.5 #1. To
change the current disk drive: choose Other
Activities from die Main Menu, and then
choose Sdect standard location of data disk. A

list of available disk drives will be displayed.
Sdect Disk 3.5 #1 and press Return. The name
of the selected disk drive will then appear in the
upper left comer of the AppleWorks screen. You
can now access the builr-in 3.5-inch disk drive.

Since AppleWorks 2.0 was written before the
creation of rhc Apple lie Plus, it expects to find
the built-in 5.25-inch disk drive of the original
Apple He instead of the built-in 3.5-inch disk
drive of the newer Apple He Plus. AppleWorks
versions 2.1 and later solve this problem; they
distinguish between the older He and the He
Plus.
Dollars & Cents Round Incorrectly

Problem: Dollars and cents do not round
correctly when multiplying, dividing, adding or
subtracting in versions of AppleWorks prior to
3.0.

Solution: Formatting dollar amounts to two
dedmal places with Open Apple-L will not
automatically round calculations to two dedmal
places. Use the @Round function to ensure
proper rounding. Due to the nature of binary
arithmetic and SANE, it may be necessary ro
add a small correction to the calculation before
applying the round function. If calculations are
nor quit rounding correctly, especially those
whose last significant digit is a "5" (eg.,
33.345), the following correction should be used
to compensate for floating point arithmetic

@Round(Calculation+.0000001,2).
Erratic Printing; ON

Problem: Erratic printing; margins are not
adhered to; columns in rhc spreadsheet or
database are misaligned; digits are dropped from
numbers; "ON" is printed at the top of the first
page-

Solution: Check the interface card code
AppleWorks defaults to the interface code for
the Super Serial card (Control-I 80N). If you arc
using a different interface card, you must change
the interface code For example, and Epson
printer connected to a Grapplcr Interface card
requires an interface code of Control-I ON.
Consult your interface card manual for the
correct setting.

AppleWorks GS:
Printing Sideways from the Data Base

You cannot print sideways in the data base
The work around it is ro copy fidd titles into die
spreadsheet and then copy all records into the
spreadsheer. You can print sideways from the
spreadsheet.
RAM Disks: AWGS Size Requirements
& Setup

If you have exactly 1.25 Megabytes of RAM
and a RAM Disk icon appears on the desktop

upon startup of your computer, you must
remove the RAM Disk before running
AppleWorks GS. To remove the RAM Disk,
follow these steps:
1. Open the Desk Accessories Menu by

pressing (Control-Open Apple-Escape)
2. Sdect the Control Pand option and press

Return.
3. Sdect RAM Disk and press Return.
4. Use the right or left arrow keys to change

both die Minimum RAM Disk Size and
Maximum RAM Disk Size to zero (check
marks should appear to the left of both
items).

5. Press Return ro save rhe new settings.
6. Sdect Quit and press Return to exit rhe

Control Panel Menu.
7. Sdect Quit and press Return to exit rhe

Desk Accessories Menu.
8. Turn off rhe Apple HGS computer with rhe

on/off switch. Wait 10 seconds; then rum
on the computer again.

9. The RAM disk icon will no longer appear
on the Apple IIGS desktop.

If a user has more then 1.25 Mb of memory
and wants to set up a RAM disk for additional
speed he or she should keep two things in mind:
1. You must have at least 1.25 Mb free

memory in addition to the RAM disk.
2. The RAM disk itself will require consider

able overhead. To set up a RAM disk that is
equivalent to 1.25 Mb will require adding
additional amount of memory to rhe RAM
disk theis overhead. This amount varies. To
get a RAM disk functioning as 1.25 Mb will
require setting up that RAM disk to be
about 1.8 Mb.

Mailing Labels:
Printing to ImageWriter Procedures

The procedure for printing mailing labels
from the AppleWorks GS database ro rhe
ImageWriter printer is slightly different from
that described in Chapter 3 of the Apple-Works
GS User's Guide.
1. Sdect Choose Printer from rhe File menu.
2. Sdect IMAGEWR1TER.CL from the

printer list.
3. If the cable from your printer is connected

to the modem port of the Apple IIGS,
select MODEM as rhc printer port. If the
cable from your printer is connected to the
printer port of the Apple IIGS, sdect
PRINTER as the printer port.

4. Click OK.
5. Sdect Page Setup from the File menu.
6. Choose US Letter, Condensed, and No

Gaps Between Pages.
7. Click OK.
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8. Sdect Slmw Definition from rhe Template
menu tti enter rhc definition screen.

9. Set the header to 0 inches in length by
dragging the header tag, represented by the
letter H to the top of the .screen.

10. Scr rhe footer to 0 inches in length by
dragging the footer tag, represented by the
letter K to the bottom of the screen.

11. Arrange rhe fidds in the desired order.
12. Set the body to the length of your mailing

labd by dragging the body tag, represented
by the letter B, to the appropriate ruler
setting. For example, if the labd is one inch
in height, drag the body icon to the one
inch mark on the ruler.

13. Go to the Form view by dicking on the
Form box at the lower left comer of the
screen. Otherwise, you will print the form
definition screen and not the labels.

14. Sdect Display Preferences from rhc
Template menu. Choose Multiple records
per form page, and dick OK.

15. Choose Print from the File menu.
16. Choose Better Text, one copy, and rhen

click OK.
Terminal Emulation

Q: Does AppleWorks GS Communication
module support VT-100 terminal emulation?

A: No. Terminal emulation is not sup
ported.Cannot Initialize Internal Modems

Q: My Hayes-compatible, 1200-baud,
internal modem doesn't seem to work in
AppleWorks GS. After I choose Internal 1200 as
the modem type and designate the slot the
modem is in as "Your Card", die message "Can't
Initialize Modem" appears. What is wrong?

A: Try setting the DIP switches or jumper
blocks of the modem so that interrupts are
enabled. AppleWorks GS does not send
interrupts; it depends on the modem to do so.
Try the same solution for other brands of
internal modems.

ClarisWorks:
AppleWorks to ClarisWorks File
Conversion

The following AppleWorks files can be
opened from within ClarisWorks:
• AppleWorks 2.0 and larer Word Processing,

Data Base and Spreadsheet files
• AppleWorks GS Word Processing files

The easiest way to convert AppleWorks files
is to use a 3.5-inch floppy disk and Apple File
Exchange Apple File Exchange is a file transfer
utility which is induded in rhe Madntosh
system software 3.5-inch floppy disk drives are
standard equipment with the Apple IIGS and
the IIc+ and arc also available for the He and He
from your Apple dealer.

Once your AppleWorks files arc saved on an
800K, 3.5-inch disk, any Madntosh with a high
density 3.5" drive, also called a SuperDrive or
FDHD can transfer them to Madntosh format.

To use Apple File Exchange
1. On the Madntosh, launch the Apple File

Exchange application by double-clicking on

its lain.
2. Insert your AppleWorks data disk in the

disk drive.
Directories of the destination disk (left side)

and source disk (right side) appear in the Apple
File Exchange window.
3. Under the ProDOS to Mac menu at the

top of the window choose Default
Translation. Make sure thar no other items
in this window arc checked.

4. Sdect the AppleWorks files to be
transferred from thdr directory.

5. Either choose an existing folder on the
destination disk for rhe files or create a new
one by clicking the New Folder burton. At
the prompt, name the new folder.

6. Click Translate
The AppleWorks files you sdected will be

translated to Madntosh files. You may either
translate more files, or choose Quit from the File
menu. Your disk will be ejected when you quit.

Open the files with ClarisWorks:
When you wish ro open your AppleWorks

files in ClarisWorks, launch ClarisWorks,
choose Open from the File menu, and navigate
to the folder which contains your translated files
and select it by dicking on its name

When the Open dialogue box appears, dick
on the Import Options flag. This will reveal a
sub-menu of file types which can be imported
by ClarisWorks. When you select the type of
document you wish to open, a list of available
files of that type will appear.

Choose the desired converted filc(s) by
clicking on its name and then dick the Open
button.

When the converted files are saved, they are
saved as ClarisWorks files and have a
ClarisWorks Icon.

Apple File Exchange can also be used to
convert ASCII (text) files in ProDOS format, as
well as MS-DOS ASCII (tcxr) files and some
MS-DOS word processing files. Once
converted, these files can be imported into
ClarisWorks.

For more information abour Apple File
Exchange, consult the reference materials which
came with your Madntosh.
Border Doesn't Print

ClarisWorks will not print borders for the
top most or left most cdls of a Spreadsheet
document when both column and row headers
arc hidden. There are a number of ways to get
around this limitation:
1. Put data in the second row or columns only
2. Copy the data from your Spreadsheet

document into a Spreadsheet frame
This problem occurs in all versions.

Can't Get More Than 50 Rows or 10
Columns

When you create a spreadsheet frame in a
word processor document, you get 50 rows and
10 columns as a default size If you try to resize
the frame larger than that or if you try to paste
more data than that, it will not work.

To enlarge the si/c of the frame, select the
frame and go under the View menu to Open

Frame. Then go under the Format menu to
Document and increase die number of rows and
columns to fit your need!:.

This situation will sometimes occur when
trying to resize across a page boundary, llic
problem is not the boundary; it is the default
size of the frame.

There is an alternate method which allows
the user to add 5 rows at a time to a spreadsheet
frame of a word processing document without
opening the frame

Create the frame and expand it to 50 rows.
Go under the Options menu to Frame Links.
An arrow will appear at the bottom of the
spreadsheet frame Click the arrow and create a
new spreadsheet frame with as many new rows
(up to 5 additional) as you want. The first row
will be row 51. Now go back and resize rhe first
frame and then you can delete the second frame

HyperCard:
HyperCard 2.X Installation

The installation instructions on page 16 of
the "Getting Started" Manual direct you to use
the installer script to install HyperCard.
However, for version 2.1 of HyperCard, the
installer script was removed, and the change plus
a new installation process was documented on
page 1.2 of the "New Features Guide". The
"HyperCard 2.1x Rdease Notes" also refers to
the new installation procedures. The following
steps can be used to install HyperCard version
2.0 or 2.1.
1. Make sure you are running System 6.0.5 or

later. HyperCard 2.x will not run on earlier
versions of the Apple operating system.

2. Create a folder on your hard disk and name
it "HyperCard 2.x".

3. Place the HyperCard Program Disk in the
floppy drive This is the disk labded
IMPORTANT on the top left

4. Open the disk to view the contents, and
drag a copy of HyperCard, Home, and
Practice files into the HyperCard 2.x folder
you jusr created. Note: Please note that it is
essential that both HyperCard and the
Home stack arc located in the same folder.
After those files are copied:

5. Eject the HyperCard disk and insert the
HyperCard stack disk.

6. Open the disk to view its contents, and
from the Edit Menu, choose Select AIL
Notice that all items on the disk are
highlighted. Now, dick any item and drag
it into the HyperCard 2.x folder. Since all
items are selected, all files from rhe
HyperCard Stack disk will be copied into
the HyperCard 2jc folder. Follow this
procedure for rhe remainder of the disks.

7. Installing HyperCard fonts -
System 6.x
Open HyperCard 2.0 folder and double dick

on the HyperCard fonts icon.
This will activate the Font/DA Mover. If you

do nor have the Font/DA Mover on your hard
disk, you can obtain it from your System Tools
disk that came with your computer. If you are



unable to locate your Systems Tools disk,
contact your dealer for a replacement, as
CIAR1S cannot replace this disk. Once the
Font/DA Mover is active, a dialog box will
appear with a list of all HyperCard fonts on the
left, and no fonts on the right.

Note Font/DA Mover version 3.8 or later is
required for the HyperCard 2.x font installation

Click the open button on the right.
Locate your System file and open it. It should

be located in your System Folder.
Sdect all the fonts on the left by dragging

down across the list of fonts, and then dick
Move.

When finished, quit the Font/DA Mover,
sdect Restart from the Spedal Menu, and you
are now ready ro use HyperCard 2 Jt.

System 7
Open the HyperCard 2.0 folder and double

click on rhc HyperCard fonts icon. This will
open a window in which you can sec all the
HyperCard fonts.

Open your system folder, and double dick
on the file labeled "System". This will open a
window showing all your current System fonts.
Click in the HyperCard Font window, choose
"Sdect All" from the Edit menu, dick on any of
the highlighted fonts, hold the mouse button
down and drag to the window displaying the
System fonts. Rdease the mouse. The Hyper
Card fonts will be copied into the system file
You can now close all open windows, eject your
HyperCard disk, and begin using HyperCard.
Converting Stacks to Version 2JC

The file format for HyperCard 2.x differs
from that of earlier versions. Stacks in the old
format can be opened read-only by HyperCard
2.x. When such a stack is opened, a standard
Macintosh padlock symbol appears in the Menu
bar, indicating the stack is read-only, and the
Compact Stack item from the File menu
becomes Convert Stack... instead.

In order to convert a stack to HyperCard 2.x
format, open the stack, choose the Convert
Stack... item, and dick OK in the confirmation
dialog box.

NOTE: Once the stack is converted to
HyperCard 2.x format, it can no longer be
opened by earlier versions of HyperCard
without using third party utilities.

Before converting a stack, keep in mind that
you can always save a copy of it by choosing
Save A Copy... from the File menu. Because the
copy is an exact duplicate of the current stack,
you can use Save A Copy... to archive versions
of your stacks in the old format or any other.

Most operations on stacks, such as entering
text into fields, creating new buttons, or editing
graphics, are not allowed until the stack is
converted. When you attempt to perform such
operations within a stack in the old format, a
dialog box appears informing you that you must
first convert the stack before performing the
operation.

submitted by Gregory L Carlson 4

AppleWorks Hints <*̂%

from RA UD and others
Loading A TimeOut Program:

If you want to load a new TimeOut
program from a disk, you must hit C3-ESC and
then select the option marked "Utilities." Your
compurer will remember the original volume
used to boot up, so it must stay in your drive
till you have selected the option for "Utilities."
Then insert the new disk in your drive If you
try to switch too soon, the disk will not be
recognized and you will nor be able to load the
TimeOut program needed.
Tabs and Going Backwards:

In rhc manual for AppleWorks 3.0, it says
that CONTROL-TAB will move the cursor
backwards towards the previous tab, but this
docs not work and appears to be a typo. To go
back, use tf-Lcft Arrow and it will jump back
one word at a time or one Tab space at a time
If the line the cursor is on is free of text, it will
return to the left column of that line.
Templates and Protection:

I recently added a template to my growing
collection. It would not accept any data. I
thought it was an error on my part until I
noticed that the protection scheme was on so
that no one could alter the template from the
author's original setup. Once I cleared the
protection, I was able to enter and use the data
any way I wanted. Always check a template
before using it by hitting CS-V and sdecting
Protection (or just the "P") and then de-
protect the template
A Quick Keyboard Trick:

If you need to move the cursor from the
middle of one line to another and nor upset
the format, don't hit the arrow key or space
key over and over. Just use 6-RETURN and
the cursor will appear at the beginning of the
next line without moving any text. If you need
to move several lines down, just repeat the
procedure the necessary number of times.
Foreign Dictionaries:

To allow the spelling checker to recognize
words with special characters, you must modify
your AppleWorks disk. This modification
comes from Alan Bird of AppleWorks fame.

BLOAD SBQ.WP,A$300,B$8PCB,L5
POKB 768,64
POKE 772,126
BSAVB SBG.HP,A$300,B$8FCB,L5

Using Sideways for Text:
If you want to use TimeOut Sideways for

spreadsheets it's a snap. That's what it was
designed for, but if you want to do the same
with a text page, what do you do? Load a new
spreadsheet onto the desktop and widen the
main column to fill the entire screen. Then
copy your word processor to the clipboard and
move it over the new spreadsheet. Print it

using the TO Sidespread module and enjoy the
results.

And from The PULP, this review of Oudiner
for AppleWorks 3.0:

Oudiner is a productivity tools that brings
outline processing to AppleWorks 3.0. It lets
you organize information up ro six levels deep.
You can use it to create to-do lists and tests,
prepare a curriculum, generate lesson plans,
organize class or presentation notes, write a
term paper, and more. Information that you
organize into different topics or levels can be
processed with Oudiner.

Oudiner modifies the AppleWorks word
processor, and is always just a keystroke away.
When you press Open-Apple +, you are taken
from the standard edit mode of the word
processor ro outline mode At this point,
outline topics can be inserted, edited, moved
around, arranged alphabetically, hidden or
expanded to reveal subtopics and body text.
You can shift a topic up or down levels and rhe
associated subtopics and body text will move
along with it. You can choose how many levds
deep the outline mode should display, and you
can even edit the body text for specific topics
while in Outliner.

Oudiner requires ProDOS, AppleWorks
3.0, Apple He, He, Hc+ or HGS, at least 128K
RAM memory (can be expanded to any
amount) and one 5.25" or one 3.5" disk drive

From DELVAC this item:
Got some TimeOut modules loaded and in

use? Need to get back to the document on
your desk at the exact place you left it? Well,
do wc have one for you. Most TimeOut
modules will return you right back to where
you left off with a simple O-S. There will be
some exceptions to the rule, but most
TimeOut programs will work. So far we know
it does not work on Graph, FilcMaster or
Tclecomm. Try it on your system and let us
know which ones work and which ones don't.

from ACES, Apple Computer Enjoyment Society
of South Florida, 3-4191
via Steve George, mini 'app 'les

[The Apple Computer Enjoyment Society is a not-for-profit
men group which has teen helping Apple and clone computer
owners since 1979.A.C.E.S. reserves Use rights to all materials
printed herein. All articles that are not protected by copyright
may be reprinted by Apple User Groups and other non-profit
computer organizations. Such reprints must give credit to the
aulltorandA.CES., Inc.. PO Box291557. Ft. Lauderdale.
FL 33329.]

submitted by Steve George
stgeorgc@pnet51.orb.mn.otgorstgeorge<3>pro-
algonauin.mn.org*
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PRELUDE:
THE APPLE III PROJECT

As we continue our travels examining the
history of the Apple II, let's fine tune the rime-
machine card on our souped-up Apple II to
concentrate spedfically on the next version of
the II, the He As before, just accelerate the
microprocessor speed to 88 MHz, and watch
out for the digital fire-trails! Destination:
1982.

Between the years 1979 and 1983, although
no new versions of the Apple II were released, ir
enjoyed a broad popularity and annually
increasing sales. The open architecture of the

-„. computer, with its fully described hardware and
^ firmware function via the Reference Manual,made it appealing both to hardware and

software hackers. Third-party companies
designed cards ro plug into the internal slots,
and thdr function varied from making it
possible to display and use 80-column text, to
docks and cards allowing the Apple II to
control a variety of external devices. During this
time there was also an explosion of new software
written for this easily expandable machine, from
the realm of business (VisiCalc and other
spreadsheet dones), to utilities, to games of all
types. Each month a host of new products
would be available for those who wanted to find
more things to do with their computer, and the
Apple II was finding a place in the home, the
classroom, and the office.

At Apple Computer, Inc, however, the
Apple II was not viewed with the same degree of
loyalty. By September 1979 the Apple 11 had
continued to be a sales leader. However, few at
Apple believed that the II could continue to be
a best seller for more than another year or two.
Since Apple Computer, Ine was a business, and
not just a vchide for selling the Apple II
computer, they began to enlarge the engineering
department to begin designing new products.'
These new design efforts had begun as far back
as late 1978. Thdr first effort was an enhanced
Apple II that used some custom chips, but that

r project was never finished. They also beganwork on a different, more powerful computer

that would use several identical microprocessor
chips sharing tasks. The main advantage would
be speed, and the ability to do high precision
calculations. This computer was code-named
Lisa, and because it was such a revolutionary
type of design, they knew it would take many
years to come to actual production. Because of
the power it was to have, Apple executives felt
that Usa was the future of the company.2,14

Because they knew that the Lisa project
would take a long time to complete, and
because the Apple II was percrived to have only
a short remaining useful life as a product, they
began a new computer project called the Apple
HI. Instead of building upon the Apple II as a
basis for this new computer, they dedded to
start from scratch. Also, although Wozniak
made most of the design dedsions for the II, a
committee at Apple dedded what capabilities
the Apple III should have. They dedded that
the Apple III was to be a business machine, and
not have the home or arcade-game reputation
that the II had. It was to have a full upper/
lowercase keyboard and display, 80-column
text, and a more comprehensive operating
system. They also dedded that since ir would be
a while before many application programs
would be available for this new computer, it
should be capable of running existing Apple II
software In some ways this handicapped the
project, since it was then necessary to use the
same microprocessor and disk drive hardware as
was used in the Apple ll.3

Apple executives also dedded that with the
introduction of the Apple 111 they wanted a
dear separation between it and the Apple II in
regards to marketing. They did not want ANY
overlap between the two. The HI would be an
80-column business machine and was predicted
to have ninety percent of the market, while the
Apple II would be a 40-column home and
school machine and would have ten percent of
the market. Apple's executives were confident
that after rhe release of the Apple HI, the Apple
II would quickly lose its appeal.4

Because of thdr desire for a strong and
distinct product separation, rhe Apple II
emulation mode designed into the Apple III was
very limited. The engineers actually ADDED
hardware chips that prevented access to the Ill's
more advanced features from Apple II
emulation mode. Apple II emulation couldn't
use 80 columns, and had access to only 48K
memory and none of the better graphics modes.
As a result, it wouldn't run some of the better
Apple II business software during a rime when

there wasn't much NEW business software for
the Apple III.

The Apple HI engineers were given a one
year target date for completion. It was ready for
release in the spring of 1980, but there were
problems with both design and manufacturing.
(It was the first rime that Apple as a company
tried to come out with a new product; the
Apple II had been designed and built by
Wozniak what he WAS the engineering
department). The first Apple III computers
were plagued with nearly 100% defects and had
to be recalled for fixes. Although Apple took the
unprecedented step of repairing all of the
defective computers at no charge, they never
recovered the momentum they lost with that
first misstep, and the III did not become rhe
success Apple needed it to be3

Although all of the bugs and limitations of
the Apple III were eventually overcome, and ir
became the computer of choice within Apple, it
did not capture the market as they had hoped.
At that point, they weren't sure exacdy what to
do with the II. They had purposely ignored and
down-played it for the four years since the II
Plus was released, although without its
continued strong sales they would not have
lasted as a company. In a 1985 interview in
Byte magazine, Steve Wozniak stated:

"When we came out with the Apple HI, the
engineering staff cancded every Apple II
engineering program that was ongoing, in
expectation of the Apple Ill's success. Every
single one was canceled. We really perceived
that the Apple II would not last six months. So
the company was almost all Apple HI people,
and we worked for years after that to try and tdl
the world how good the Apple III was, because
we KNEW [how good it was]... If you looked
at our advertising and R&D dollars, everything
we did here was done first on the III, if it was
business related. Then maybe we'd consider
doing a sub-version on the IL To make sure
there was a good boundary between the two
machines, anything done on the II had to be
done at a lower level than on the III. Only now
are we discovering that good solutions can be
implemented on the II... We made sure rhe
Apple II was nor allowed to have a hard disk or
more than 128K of memory. At a time when
outside companies had very usable schemes for
adding up to a megabyte of memory, we came
out with a method of adding 64K to an Apple
He, which was more difficult ro use and
somewhat limited. We refused ro acknowledge
any of the good 80-column cards rhat were in



the outside world - only ours, which had a lot
of problems."4

Wozniak went on in that interview to say
that at one time he had written some fast disk
routines for the Pascal system on the Apple II,
and was critidzed by rhc Apple HI engineers.
They didn't think that anything on the II
should be allowed to run faster than on a III.
That was the mindset of the entire company at
the time

Apple has been much maligned for rhe
attention they gave the Apple HI project, while
suspending all further development on the
Apple II. They pegged thdr chances for the
business marker in 1980 on the Apple HI. Even
Steve Wozniak had stated in another interview,
"We'd have sold tons of [computers in the
business market] if we'd have let the II evolve...
to become a business machine called the HI
instead of developing a separate, incompatible
computer. We could have added the accessories
to make it do the business functions that the
outside world is going to IBM for."3 Part of the
problem was rhc immaturity of the entire
microcomputer industry at the time There had
NEVER been a microcomputer that had sold
wdl for more than a couple of years before it
was replaced by a more powerful modd, usually
from another company. The Altair 8800 and
IMSAI had fallen to the more popular and
easier to use Apple II and TRS-80 and
Commodore PET, as well as other new
machines based on rhc Intel 8080 and 8088
processors. It is entirely understandable that
Apple's attitude between 1978 and 1980 would
be of panic and fear that dicy wouldn't get a
new computer out in time to keep their market
share and survive as a company. However,
during the entire time when Apple was working
on the HI as a computer to carry the company
through until Lisa would be ready, and during
the entire time that rhe Apple II was ignored by
its own company, it continued to quietly climb
in sales. It is a credit to both the ingenuity of
Wozniak in his original design, and ro the users
of the Apple II in THEIR ingenuity at finding
new uses for the II, that its value increased and
stimulated yet more new sales. The Apple II
"beat" the odds of survival that historically were
against it

THE APPLE HE:
BEGINNINGS

When Apple saw that rhe sales on rhe Apple
II were NOT going to dwindle away, they
finally dedded to rake another look at it. The
first new look at advandng the design of the II
was with a project called "Diana" in 1980.
Diana was intended primarily to be an Apple II
that had fewer internal components, and would
be less expensive to build. The project was later
known as "LCA", which stood for "Low Cost
Apple". Inside Apple this meant a lower cost of
manufacturing, but outsiders who got wind of
the project thought it meant a $350 Apple II.
Because of that misconception, the final code
name for rhe uj>dated Apple II was "Super II",

and lasted until its release.5
HARDWARE

Part of the He project grew out of the earlier
work on custom integrated circuits for the
Apple II. When they finally decided to go ahead
and improve the design by adding new features,
one of the original plans was to give the Apple
II an 80-column text display and a full upper/
lowercase keyboard. Walt Brocdncr at Apple
did much of the original hardware planning,
and was one of those at Apple who pushed for
the upgrade in the first place. To help maintain
compatibility with older 40-column software
(which often addressed the screen directly for
speed), he dedded to make 80-columns work
by mirroring the older 40 column text screen
onto a 1K memory space parallel to it, with the
even columns in main memory and the odd
columns in this new "auxiliary" memory. To
display 80-column text would require switching
between the two memory banks. Broedner
realized that with lirdc extra effort he could do
the same for the entire 64K memory space and
get 128K of bank-swirchable memory. They put
this extra memory (the IK "80-column card, or
a 64K "extended 80-column card") in a special
slot called the "auxiliary" slot that replaced slot
0 (the 16K Language Card was going to be a
built-in feature). The 80-column firmware
routines were mapped to slot 3, since that was a
location commonly used by people who bought
80-column cards for their Apple H's, and was
also the place where rhc Apple Pascal system
expected to find an external terminal. The
auxiliary slor also supplied some special video
signals, and was used during manufacture for
testing on the motherboard

The engineers that worked on the He tried
hard to make sure that cards designed for the II
and II Plus would work properly in the new
computer. They even had to "tune" the riming
on the ne to be slightly OFF (to act more like
the II Plus) because the Microsoft CP/M
Softcard refused to function properly with the
new hardware A socket was induded on the
motherboard for attaching a numeric keypad, a
feature that many business users had been
adding (with difficulty) to the II Plus for years.
The full keyboard they designed was very
similar to the one found on the Apple III,
induding two unique keys that had first
appeared with the III - one with a picture of an
hollow apple ("open-apple") and the other with
the same apple picture filled in ("solid-apple").
These keys were electrically connected to
burtons 0 and 1 on the Apple paddles or
joystick. They were available to software
designers as modifier keys when pressed with
another key; for example, open-appIe-H could
be programmed to call up a "hdp" screen. The
newer electronics of the keyboard also made it
easier to manufacture foreign language versions
of the Apple He6

Overall, Broedner and Peter Quinn (the
design manager for the He and later the lie
projects) and thdr team managed to decrease
the number of components on the motherboard

from over one hundred ro thirty-one, while
adding to the capabilities of the computer by
the equivalent of another hundred components.
FIRMWARE

Peter Quinn had to beg for someone to help
write the firmware revisions to the Monitor and
Applesoft for rhe He. He finally got Rich
Auricchio, who had been a hacker on the Apple
II almost from the beginning. Quinn said in a
later interview, "You cannot get someone to
write firmware for rhis machine unless he's been
around for three or four years. You have to
know how to get through the mine fidd [of
unofficial but commonly used enrry points]. He
[Rick] was exrremdy good. He added in all the
80-column and Escape-key stuff." Quinn also
got Bryan Stearns to work on the new
Monitor.6,7

Changes were made in the ROMs to support
the new bank-switching modes made necessary
by having two parallel 64K banks of RAM
memory. To have enough firmware space for
these extra features, the engineers increased the
size of the available ROM by making IT bank-
switched. This space was taken from a location
that had previously not been duplicated before
- the memory locations used by cards in the
slots on the motherboard. Ordinarily, if you use
the Monitor to look at the slot 1 memory
locations from SC100 through SCI FF, you get
dther random numbers (if the slot is empty), or
the bytes that made up the controller program
on that card. Any card could also have the space
from $C800 through SCFFF available for extra
ROM code if they needed it. If a card in a slot
did a read or write to memory location SCFFF,
the SC800-SCFFF ROM that belonged to that
card would appear in that space in the Apple II
memory. When another card was working, then
ITS version of that space would appear. On the
He, they made a special soft-switch that would
switch OUT all the peripheral cards from the
memory, and switch IN the new expanded
ROM on the motherboard. The firmware in the
new bank-switched ROM space was designed to
avoid bdng needed by any card in a slot (to
avoid conflicts), and much of it was dedicated
to making the 80-column display (mapped to
slot 3) work properly.

Also added were enhancements to the ESC
routines used to do screen editing. In addition
to the original ESC A, B, C, and D, and rhe
ESC I, J, K, and M added with the Apple II
Plus, Auricchio added the ability to make the
ESC cursor moves work with the left and right
arrow keys, and the new up and down arrow
keys. The new He ROM also induded a self-test
that was activated by pressing both apple keys,
the control key, and RESET simultaneously.9
SUCCESS

The new Apple He turned our to be quite
profitable for Apple Not only was ir more
functional than the II Plus for a similar price,
but the cost to the dealers selling it was about
rhree rimes the cost of manufacture. They had
gotten their "Low Cost Apple", and by May of
1983 the Apple He was selling sixty to seventy
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thousand units a month, over twice the average
sales of die 11 Plus. Christinas of 1983 saw the
lie continue to sdl extremely well, partly
resulting from the ddayed availability of the
new IBM PCjr. Even after the Apple lie was
released in 1984, He sales continued beyond
those of the He, despite the He's built-in
features.8
MODIFICATIONS

Early Apple He motherboard's were labeled
as "Revision A". Engineers determined soon
after its introduction that if the same use of
paralld memory was applied to the hi-res
graphics display as was done with the text
display, they could create higher density
graphics. These graphics, which they called
"double hi-res", also had the capability of
displaying a wider range of colors, similar to
those available with the original Apple II lo-res
graphics. The He motherboards with the
necessary modifications to display these double
hi-res graphics were labded "Revision B", and a
Softswitch was assigned to turning on and off
rhe new graphics mode.

Later versions of the He motherboards were
again called "Revision A" (for some reason),
although they HAD been modified for double
hi-res graphics. The difference between rhe two
"Revision A" boards was that the latter had
most of the chips soldered to the motherboard.
An original "Revision A" board that had been
changed to an Enhanced He was not necessarily
able ro handle double hi-res, since rhc change to
the Enhanced version involved only a four-chip
change to the motherboard, but not the changes
ro make double hi-res possible.9
THE ENHANCED IIE

This version of rhe Apple He was introduced
in March of 1985. It involved changes to make
the He more dosely compatible with the Apple
He and II Plus. The upgrade consisted of four
chips that were swapped in the motherboard:
The 65c02 processor, with more assembly
language opcodes, replaced the 6502; two more
chips with Applesoft and Monitor ROM
changes; and the fourth a character generator
ROM that induded graphics characters (first
introduced on the He) called "MouseText". The
Enhanced lie ROM changes fixed most of the
known problems with the He 80-column
firmware, and made it possible to enter
Applesoft and Monitor commands in lower
case The older 80-column routines were slower
than most software developers wanted, they
disabled interrupts for too long a time, and
there were problems in making Applesoft work
properly with rhe 80-column routines. These
problems were solved with the newer ROMs.

Monitor changes also induded a return of
the mini-assembler, absent since rhe days of
Integer BASIC. It was activated by entering a
"!" command in the Monitor, instead of a jump
to a memory location as in the older Apple ]f.
Also added were an "S" command was added to
make it possible to search memory for a byte
sequence, and the ability to enter ASCII
characters directly into memory. However, the

"L" command to disassemble 6502 code still
did not handle the new 65c02 opcodes as did
the He disassembler. Interrupt handling was also
improved.

Applesoft was fixed to let command* such as
GET, HTAB, TAR, SPC, and comma tabbing
work properly in 80-column mode

The new MouseText characters caused a
problem for some older programs at first, until
they were upgraded; characters previously
displayed as inverse upper-case would
sometimes display as MouseText instead.10,11
THE PLATINUM IIE

This version of the He, introduced in January
1987, had a keyboard that was the same as the
IIGS keyboard, bur the RESET key was moved
above the ESC and "1" keys (as on the He), and
the power light was above the "/" on the
induded numeric keypad (the internal numeric
keypad connector was left in place). The
CLEAR key on the keypad generated the same
character as the ESC key, but with a hardware
modification it could generate a Ctrl-X as it did
on the IIGS. The motherboard had 64K RAM
in only two chips (instead of the previous dght),
and one ROM diip instead of two. An
"extended 80-column card" with 64K extra
memory was induded in all units sold, and was
smaller than previous versions of that memory
card.

No ROM changes were made The old shift-
key modification was installed, making it
possible for programs to determine if the shift-
key was being pressed. However, if using a game
controller that actually used the third push
button (where the shift-key mod was internally
connected), pressing shift and the third push
button simultaneously causes a short drcuit that
shuts down the power supply.12
EMULATION CARD ON
MACINTOSH LC

In early 1991, Apple introduced a new
version of the Apple He This one was designed
to be exacdy like the 128K Platinum He, with
the modification that it had a color Macintosh
attached to it. This Apple He cost only $199,
but the required Macintosh peripheral went for
about $2,495, which makes the combination
the most expensive Apple II ever made Apple
engineers managed to put the function of an
entire He onro a card smaller than the old Disk
II controller card. With version 2.0 of the Apple
II interface software, more of rhe memory
allocated to rhe Macintosh can be used by the
He (strange way of designing an Apple II!).
However, unlike all previous versions of the He,
there are no hardware-based slots on the He
card; instead, there are software-based slots that
are allocated by moving icons thar represent
various peripherals into "slots" on the Mac
screen. (Oh, yes; ir runs some Mac software,
too).

To use 5.25 disks with this Apple He, there is
a cable that attaches to the card. The cable splits
into a game connector (for paddles or joystick
operation) and a connector that accepts He and
IIGS style 5.25 drives. The He card runs at a

"normal" (1 MHz) speed and a "fast" (2 MHz)
speed.13 I r has limitations, however. For a 1991
Apple II, it is limited in being unable to be
accelerated beyond 2 MHz (a Zip Chip can run
a standard Heat 8 MHz), and the screen
response seems slow, since it is using a software-
based Mac text display instead of the hardware-
based Apple 11 character ROM. As a Madntosh
it lacks the power and speed of rhe newer
Madntosh II models (which also run in color).
But if having a Apple 11 and a Mac in one
machine is important, this is rhe best way ro do
it.

NEXT INSTALLMENT:
The Apple lie
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12 twin Cities
Computer

Stores Refer
Apple Computer

Owners to
RAMCO

NOWAVAILABLE:
• Over 1000

Apple II Programs
-Games
-Educational
-Productivity
-Science, etc.

• Memory Expansion
• Used Disk Drives-

Closeout- $65 each
(some half-height)

• System Manuals
• Program Instruction
• Modems
• Hard-to-Find Items
• Free Software

CatalogueSheets

Just Call!
What's not in stock

can be here by 10 AM
the next day!

RAMCO Sales
Call: (612) 561-8144
Ask for Rodger Kent

#

Murray Jr. High School
Location for Apple II Novice SIG,

AppleWorks SIG,
Mac Programmers' SIG,
and occasional others.

* «

AppleWriter Quick Tip #4
by Steve George

Most of the examples in the manual use the 'less-than' character (<) as the delimiter for
search strings. This is fine 'n dandy unless you want to be able to search for rhc characters used
in defining the string: <, >, ?, or =. What to do... What to do?

Just pick an alternate delimiter character. *Somewhere* in your manual will be listed the
acceptable delimiter characters, and rhe corresponding symbols which substitute for "any single
characrcr," "any length string of characters," and "the return character".

Here's a small chart showing the usage of the default ( < ) ddimiter and the ( # ) ddimitcn

Delimiter
<
ft

Return Char Any Single Char
?
&

Any Length String
s

$
For rhe other delimiters and corresponding special characters, consult your manuaL

Steve George — stgeorge@pnet51.orb.mn.org #

Twin Cities Computer Network

7-E-l
349-6200

Logon Please: TCCN

We're Growing & Changing.
Give us a call. You'll like what you see.

•Many Forums •E-mail
•PBS Schedules •USA Today
•Private SIGs -Flea Market

•Star Tribune Roundtables
•Product Testing & MORE!!!

IT'S FREE!!

y \Ju
/ ^ \

rHr^FlBfcJgUjlll



Name:.

Street:.

City:_
Home phone:
Member ID# fit applicable):.

PLEASE PRINT

State: ZIP:
Work phone:

Expiration date:.

i * rwS^piei$6myoi]r: lD*
mentmTingfab6Jhir&(0r Name' - pwvkf&thecorr&ponding

\ {nformitiOiX.BQStmyau Street
: :\ Mvivmnytrtkm Ciw st t ZIP
addre&OntheHmMvd.{ uiy'&iaie'

Atew and flenewing Members—
specify your level of support:

D Individual $25.00
D Student'.. $15.00
□ Sustaining $40.00
D Fo re ign $40 .00
D Educational $50.00
Q Corporate $100.00

*Mu3 be afuB-tima auctem
al an accredited institution.

Make checks
payable to

"Mini'app'les"

If this is a new
membership, or a

renewal, please
take a few minutes

to fill out the
questionnaire.

Your New Member
kit will arrive in 3 to

6 weeks.

Which personal computers) do you use?
Q Apple II
G Apple III
D Apple He
D Apple He
Q Apple !lc+
□ Apple IIGS
D Laser
□ Other

G Toaster Mac-68000
(128,512, Plus, SE, Classic)

D Other 68000 (Mac Portable,
PowerBook 100)

a Mac 68020 (II, LC)
D Toaster Mac-68030

(SE/30, Classic II, Classic III,
Performa 200)

G Mac Hx, Hex
□ Mac Ilsi, Ilci, Hfx, LCIL

Performa 400
D Mac IIvx, Performa 600
D PowerBook 140-180
n PowerBook Duo 180-230
□ Quadra 700-950
G Centris

What attachments or
peripherals do you use?
O QuickDraw printer
D PostScript printer
D Modem
G Scanner/digital camera
G Drawing tablet
Q Voice mail
G MIDI
G Olher

What are your areas of
special interest?
G Business applications
□ Household applications
G Educational applications
G Desktop publishing
G Programming
G Networking
G Games
G Other

G Check if you want your name
withheld from commercial and
other non-dub mailing fists

G Check if you are interested in
volunteer opportunities (see
other side)

G If you were referred by a dub
member, please give name:

eDOM
Orders

Prices:
5.25" eDOM:
5.25" System:
3.5" eDOM:
3.5" System:
Mac System 7:

$3.00
$1.00
$5.00
$3.00

$15.00
(Prices indude 6% Minnesota sales tax)

Disk size eDOM Title or Description

Current Apple System Software

Apple n,II-r//c,//e
V e r s i o n D a t e F o r m a t

DOS 3.3 System Master n/a 09/10/85 5.25"
Apple II System Disk 3.2 07/16/90 5.25/3.5"
P r o D O S 8 1 . 9 0 7 / 1 6 / 9 0 5 . 2 5 / 3 . 5 "
Apple IIGS

Qty. Price® Total

Total merchandise

Double price for non-members

Add $1/disk shipping ($4.00 max)

GS/OS Sys tem (6 d i sks ) 6 .0 4 /92 3 .5 "
H y p e r M o v e r ( 2 d i s k s ) n / a n / a 3 > 5 *

Make checks
payable to

'Mini'app'les"

Grand
Total:
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Newsletter
Ad Rates

1/12 Page
2 . 5 ' w . x 2 . 5 ' h . $ 1 0 . 0 0

1/6 Page
2 . 5 ' w . x 5 " h . $ 2 0 . 0 0 *

1/3 Page
2.5 'w.x lO'h.Ver t . $40.00
5 ' w . x 5 ' h . H o r z . $ 4 0 . 0 0

HALFPaee
7.5' w. x 5' h. Less 5% $60.00

2/3 Page
5'w.x 10'h. Less 7% $80.00

FULL Page
7.5'w. x 10'h. Less 15% $120.00

Frequency Discounts
Six months® 5%
One year @ 15%

Outside Back Cover
7 . 5 ' w. x 7 . 5 ' h . $ 1 0 0 . 0 0

Inside Back Cover
7 . 5 ' w. x 1 0 ' h . $ 1 2 0 . 0 0

Mail Inquiries to:
P.O. Box 796

Hopkins, MN 55343

Phone Inquiries to:
Keven Kassulker (612) 535-2968

For Sale:
Quadra 950 - 28mb RAM
Mac Plus - 4mb RAM
9600 baud modem
ImageWriter II
Apple CD 300e

Call Bob at 559-1124

Wanted:
Person or persons interested in
founding a "Telecommunications
SIG", dealing with modems,
bulletin-board systems, FidoNet,
InterNet, and all that cool stuff.

Call our club president,
544-8252.

HyperActive Software
professional HyperCard* solutions

(612)724-1596
C U S TO M D ATA B A S E S O N L I N E D O C U M E N TAT I O N

MUG NEWS SERVICE
ir/ri

PI Cactus Software &
Communications, Inc.

Documentation Services for:
Computer Software
Technical Manuals
Military Standards
Training Courses

Presentations
Proposals
Brochures

'Sharp and to the point'
612 / 757-6916 Fax 757-4515
Supplying quality services since 1983
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